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XLViewer Overview 

What is XLViewer 
XLViewer is a program that allows you to create a complete viewing environment for Excel workbooks and 
worksheets without any ability to edit the data contained in those worksheets. 
XLViewer utilizes a customized version of Microsoft's Excel Viewer, removing any item that allows access to the 
directories of your system and any item that allows access to editing features.  This provides your users with a safe 
environment with which to view files on your system. 
However, the customization of the Excel Viewer does not stop there.  Through the XLView Designer, you can 
specify what options you would like the Excel Viewer to have and which to remove. 
But, XLViewer is not just a Excel Viewer customization program.  XLViewer can contain a list of directories on 
your system.  By choosing one of those directories, a list of files from that directory is displayed.  Any file chosen is 
opened in the Excel Viewer.  This affords you complete control over the content of the Excel Viewer. 

Excel Viewer vs. XLViewer 
The Excel Viewer is a free program provided by Microsoft that allows you to open Excel workbooks and worksheets 
without having Excel on you system.  You may be asking yourself, "If the Excel Viewer can open Excel files, why 
do I need to use XLViewer?" 
There are a few important reasons.  They are as follows: 

• XLViewer removes the Open for Editing option that the Excel 
Viewer provides.  This prevents users from editing valuable data. 

• XLViewer can open the Excel Viewer on top of other 
applications and keep it always on top.  This prevents the Excel Viewer from getting lost underneath HMI displays. 

• XLViewer allows the Excel Viewer to be totally customizable.  
Options like printing and data analysis can be disabled preventing users from performing unwanted actions. 
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Installation 

Software Installation 
Prior to installing XLViewer onto your system, you must have the Microsoft Excel Viewer loaded.  Failure to do this 
will result in an incomplete installation of XLViewer. 
The Excel Viewer has been provided on the installation CD.  

Setting Up XLViewer 
Before installing XLViewer on your system, it is recommended that you close all other applications.  If you are 
reinstalling XLViewer, you should first uninstall the previous version of XLViewer before you go ahead with this 
installation. 
 
Run Setup.exe 
Double-click on file Setup.exe.  This setup program will take you step by step through the installation of XLViewer.  
You can quit the setup at anytime by selecting the Cancel button. 
The setup program allow you to put XLViewer on your system in the destination folder you specify.  (The default is 
folder C:\Program Files\XLViewer.)  The specified folder will be created for you if it does not exist. 
XLViewer allows you to put your viewer configuration files into a single directory.  (We recommend you use the 
directory C:\Program Files\XLViewer\XLVoutput).  This directory will be created for you. 
 

Registration 
Until you have registered, you will only be able to design viewer configurations, but will not be able to run 
XLViewer. 
There are two methods of registration.  The first is via a hardware key provided by your supplier.  This automatically 
registers you.  Failing the hardware key, you can register by receiving a software key after installation.  The 
following describes registering via software key. 

Procedure 

 
To register XLViewer, double click the Registration icon in the XLViewer program group. 
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Select Options, Register for Evaluation from the menu bar.  A form requesting you to fill out your name, company, 
and company address is displayed. 
Fill out your information and press the Get Lock button to retrieve the lock code.  The lock code is displayed in the 
Lock field.  The registration status is now:  "XLViewer Usage - partial".  You will be able to run only a sample 
configuration for XLViewer. 
Contact SyTech, Inc. with this lock code to receive a key code when you decide to purchase XLViewer.  After you 
have received the key code, start the registration program and select Options, Enter Key.  The key entry display 
opens. 

 
Enter your key and press OK.  The registration status turns to "XLViewer - Full".  The XLViewer registration is 
completed and the program can be closed. 
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The How to… Guide 

Configuring the Viewer 
All of the configuration for the Viewer takes place in the View Designer, in which you can completely customize the 
Viewer.   

How to Select a Style 
XLViewer provides 3 distinct styles of display.  Each one of these styles provides a unique way of viewing reports. 
To select a style, under the Appearance tab, click the appropriate style radio button. 
For more information about the distinctive styles provided, see XLViewer Styles. 

How to Position and Size the Viewer 
The Viewer can be positioned and sized to conform to your viewing needs. 
To position and size the Viewer, under the Appearance tab, click the Launch Viewer button.  This will open the 
Excel Viewer.  Move and size the Excel Viewer to the size and position you want.  When you have determined the 
proper size and position, return to the View Designer and click the Get Positions button.  This will close the Viewer 
and store the size and position you set. 
Depending on the style selected, the XLViewer's size and position will be determined accordingly. 

How to Adjust XLViewer for Large Font Sizing 
If your system is set for Large Fonts, XLViewer can be adjusted accordingly. 
To adjust XLViewer for large fonts, under the View menu, check the Large Font Sizing option. 
This setting will also adjust the XLView Designer for your large font settings.  The Designer will be adjusted the 
next time it is opened. 

How to Keep XLViewer Always on Top 
XLViewer can be configured so that it is Always on Top of every other window on the screen.  This is important 
when using XLViewer with an HMI display because it ensures that XLViewer will not become lost under the 
display. 
To set XLViewer to be Always on Top, under the Appearance tab, check the Always on Top option.  This option is 
checked by default. 

How to Save the Last Position of XLViewer 
XLViewer can be configured to keep the last position it was in before it was closed.  The next time XLViewer is 
opened, it will open in that last position. 
To enable this option, under the Appearance tab, check the Save Last Position option. 
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How to Show/Hide Excel Viewer's Menu Options 
XLViewer allows you to specify which of Excel Viewer's menu options you wish to show and wish to you wish to 
hide.  Every option is listed under the Menus tab. 
To hide a menu option, uncheck the appropriate checkbox for that menu option.  To hide an entire menu, uncheck 
the Enable checkbox for the appropriate menu. 

How to allow the Viewer to be moved 
XLViewer can be configured so that it can be moved around the screen.  To enable  this option, under the Menus tab, 
check the Move option.  This is enabled by default. 

How to Configure a Directory of Files 
XLViewer requires you to assign one or more directories to the Viewer to provide files to be displayed in the 
Viewer.  This configuration takes place under the Directories and Files tab.  Here you can specify a start file, the 
directory path, an alias name for the directory, and a file filter. 
 
How to set a specific Start File 
When a directory is selected in the XLViewer, the first file shown the Viewer can be the start file set for the 
directory.   
To set the start file for the directory, either enter the name manually in the Start File field or use the browse button to 
open a file browser where you can choose the specific start file. 
How to use the Most Recent file in the Directory as a Start File 
By default, if no start file is specified, when the directory is selected in the XLViewer, the most recently saved file 
that satisfies the file filter is displayed in the Viewer.   
Therefore, to use the most recent file as the start file, do not enter a file in the Start File field and set the filter to .xls, 
or to Flow.xls if you want the latest Flow File. 
How to specify a Directory path 
A full path to the directory containing files to show must to be specified.  If you used the file browser to choose a 
start file, the path to that start file is automatically entered into the Directory field.  If not, set the path by manually 
entering the full path to the directory in the Directory field. 
(Here's a tip, if you are not sure of the full path to the directory, use the start file browse button and choose a file out 
of the directory.  This will put the full path in the Directory field.  Then, delete the start file out of the Start File 
field.) 
How to Specify a Directory Alias 
A Directory Alias is a logical name you give the directory you specify.  This is the name that will be visible in the 
XLViewer.   
To specify a Directory Alias, enter a name into the Directory Alias field. 
How to Set a File Filter on the Directory 
The File filter allows you to block out all the files in the directory that do not contain what is specified in the File 
Filter field.  By default *.xls is set for the File Filter.  This means that only files with the extension .xls will be listed 
for the directory selected.  Please note that only .xls files can be shown in the Viewer, so .xls must always be 
specified in the File Filter setting. 
To set the file filter, enter it into the File Filter setting.  For example, if you only wanted to show Excel files starting 
with the word "Chemical" in them, you could enter "Chemical*.xls" and only those files starting with  "Chemical" 
will be listed. 
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How to Set the Directory to be the Startup Directory when XLViewer is deployed 
You can specify the directory to be selected automatically when XLViewer is displayed.  Either the start file or the 
most recent file satisfying the file filter will automatically be opened in the Viewer and all the filtered files in the 
directory will be listed. 
To set the directory as the Startup Directory, check the Startup Directory checkbox in the XLView Designer.  Please 
note that only one directory can be set as the startup directory. 
How to Insert the Directory Settings into the list of Configured Directories 
Once you have configured the directory settings, click the Insert button to put the settings in the list. 

How to Modify a Configured Directory 
To modify a configured directory, select the directory from the Directory List.  All of the configured settings will 
appear in the appropriate field boxes.  From here, you can alter the settings you wish.  Once you have completed you 
alterations, click the Modify button to put the settings back in the list. 

How to Delete a Configured Directory 
To delete a configured directory, select the directory from the Directory List.  All of the configured settings will 
appear in the appropriate field boxes.  From here, click the Delete button to remove the settings from the list. 

How to Assign Multiple Directories 
You can assign up to 9 directories for the XLViewer. 
To assign multiple directories, complete a directory configuration setting and click the Insert button.  The settings 
will be added to the Directory List. 

How to Label the Directories and Files 
You can specify the Labels that will appear above the Directories and Files listed in the XLViewer. 
To set the Labels, enter the text you desire in the Directories Label and File Labels textboxes.  These are located 
under the Directories and Files tab. 

How to Save a Viewer Configuration File 
Once you have created a complete viewer configuration file, you must save it for deployment. 
To save the file, choose File->Save.  Every viewer configuration file has the file extension .xlv and should be stored 
in the working directory for XLViewer established during installation. 

How to Test the Viewer Configuration 
Once a viewer configuration file has been saved, it can be tested from within the XLView Designer environment. 
To test the configuration, select File->Execute.  This will show you how your viewer configuration will appear when 
it is deployed. 
Please note that File->Execute will show the Viewer using the last saved version of the viewer configuration file, so 
if you have made any modifications to the viewer configuration file that have not been saved, you will not see them 
until you have saved them. 

Running the Viewer 
XLViewer requires one parameter in order to run: the proper viewer configuration file.  The viewer configuration file 
can be specified without the full path to the file if the file is contained in the XLViewer working directory.  
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However, if this is not the case, the full path to the viewer configuration file must be specified, i.e., 
C:\temp\xlviewer.xlv. 

How to Start the Viewer from the Desktop 
You can run XLViewer directly from the Command Line using the program XLViewer.exe. 
You can open up a Command Window, or use the taskbar’s Start, Run. 
For example: 
XLViewer.exe style1.xlv 
Where style1.xlv is contained in the XLViewer working directory. 

How to Start the Viewer through a VB(A) application 
You can also run XLViewer through a VB(A) application.  This is done by using the Call Shell() function and 
providing the necessary parameter. 
For example: 
Call Shell ("XLViewer.exe style1.xlv", vbNormal) 
Where style1.xlv is contained in the XLViewer working directory. 

How to Start the Viewer through an HMI display 
XLViewer can be run from an HMI display.  Please see the chapter "XLViewer and the HMI" for details pertaining 
to your specific HMI. 
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XLViewer Reference Guide 

XLViewer Architecture 
XLViewer consists of two main components, the View Designer (XLView Designer) and the Viewer (XLViewer).   

The View Designer (XLView Designer) 
The XLView Designer provides an environment to configure every facet of the Viewer to meet your specifications. 
In the XLView Designer you can determine how you would like the Viewer to appear.  You have control over 
everything from the Viewer's style to its position and size on the screen. 
In addition, you have the flexibility to choose which menu items you would like enabled within the Viewer.  You can 
determine whether or not you will give the user the power to print reports, filter tables of data in the report, copy data 
out of the report to the system clipboard and many of the other options the Viewer provides. 
You also have control over what files the Viewer can show.  Within the View Designer you can specify specific 
directories and certain files in those directories for viewing purposes. 
Once you have established all the settings and options provided in the View Designer, save your viewer 
configuration file. 

The Viewer (XLViewer) 
The Viewer is opened with a specified viewer configuration file established in the View Designer. 
Depending on the style chosen, the Viewer can either appear with the XLViewer containing lists of directories and 
files with Excel Viewer appearing beneath containing the file selected, or the XLViewer can be completely hidden 
with Excel Viewer showing a specific file. 
XLViewer has total control over what files can be shown in the Excel Viewer.  All of Excel Viewer's file opening 
abilities have been suppressed.  This gives you total control over the files that can be viewed from the system.   

XLViewer Styles 
There are three distinct styles in which XLViewer can be shown depending on your specifications.  Each style is 
unique giving you the flexibility you need for your viewing environment. 
The styles are as follows:    
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Style 1 

 
Style 1 consists of XLViewer attached to the top of the Excel Viewer with XLViewer controlling the Excel Viewer. 
Using this style, the Excel Viewer can only move (if moving is enabled) when XLViewer is moved and no resizing 
is allowed. 
In this style, a list of directories and files are available allowing the user to choose any directory specified to populate 
the list of files contained in that directory you have configured to show.  Once the file list is populated, the user can 
select a file out of the list to display in the Excel Viewer. 
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Style 2 

 
Style 2 consists of XLViewer appearing at the top of the screen without any window controls and the Excel Viewer 
free floating on the screen. 
In this style XLViewer cannot be moved, but the Excel Viewer can be moved and resized if those options are 
enabled. 
Just as in Style 1, a list of directories and files are available allowing the user to choose a file from a directory listed. 
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Style 3 

 
Style 3 consists of XLViewer being invisible and the Excel Viewer free floating on the screen. 
In this style the Excel Viewer can be moved and resized if those options are enabled. 
Unlike in Style 1 and Style 2, in this style only one file can be opened in the Excel Viewer.  The file that is opened 
can either be specified directly or be the most recent file in a specific directory that satisfies the file filter.   

XLView Designer 

 
The XLView Designer is used to create viewer configuration files for the XLViewer.  A viewer configuration 
determines how the XLViewer will appear, what menu options the Excel Viewer will have and what directories and 
files will be shown by the Excel Viewer. 
Multiple configuration files can be built and maintained to provide different views when reflected in the HMI. 
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The XLView Designer can be started from the XLView Designer shortcut from the desktop program folder (i.e., 
Start Programs XLViewer). 
When the Designer is started, the user is presented with a menu bar of options, a toolbar that provides easy access to 
the certain menu options and three tabs pertaining to the facets of XLViewer that can be configured.  Each tab 
contains a help button that accesses the specific section of the Online help pertaining to the specific tab. 
Online help is also provided from the Help menu option or pressing the function key F1.  Tool tips and a status bar 
are also provided to assist you whilst using the Designer. 

Menu Options 
The XLView Designer provides menu options to create a working viewer configuration file.  The menu options are 
File, Edit, View and Help and are described as follows: 
File 

 
This menu option is used to save, load new and test viewer configuration files.  
New (Ctrl+N) 
This item opens a new viewer configuration file with only default selections enabled and places the default filename 
untitled.xlv in the title bar.   
Open (Ctrl+O) 
This item loads a previously created viewer configuration file for viewing and editing..  By choosing this item, the 
open dialog box is displayed showing a list of existing viewer configuration files in the working directory.   
Save (Ctrl+S) 
This item saves the current viewer configuration to the XLViewer working directory. 
Save As 
This item saves the current viewer configuration to a specified filename.  Enter a name for the viewer configuration 
and press OK. 
Execute 
This item allows you to test the current viewer configuration by opening XLViewer using the viewer configuration 
currently opened.  The viewer configuration must be saved before using this item. 
Most Recent Used 
This is a list of the last four viewer configurations opened with the most recent configuration on top for easy 
accessibility.   
Exit 
This item closes the XLView Designer   
Edit 
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This menu is used to alter user input.  A menu item is grayed when it cannot be used. 
Undo 
This item undoes the last action performed in the XLView Designer. 
Cut 
This item removes selected text from the screen and holds it on the clipboard for later use. 
Copy 
This item duplicates selected text and holds it on the clipboard for later use. 
Paste 
This item places the contents of the clipboard into the area selected on the screen. 
 
View 

 
This menu is used to enable and disable the Designer Toolbar and Status Bar. 
Large Font Sizing 
The Large Font Sizing specifies the use of large fonts in XLViewer.  If your system is using large fonts as one of its 
system settings, you should enable this setting. 
This setting also will adjust the XLView Designer for you.  If the Designer appears with both vertical and horizontal 
scroll bars, enable this setting and close down the Designer.  When you open the Designer next, it will be adjusted 
for the large fonts set on your system. 
Toolbar 
This item is used to enable or disable the toolbar icons provided by the XLViewer Designer.  The checkmark 
indicates that the item is enabled. 
Status Bar 
This item is used to enable or disable the Status Bar in the bottom left corner of the XLView Designer.  The Status 
Bar indicates the state your current schedule is in. The checkmark indicates that the item is enabled. 
Help 
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This menu option is used to access the online help for XLViewer as well as version and copyright information 
pertaining to the  XLView Designer. 
Contents 
This item is used to access the Online Help for XLViewer.   
Online help can also be accessed from the XLView Designer by hitting the F1 key on your keyboard. 
How to Guide 
This item is used to access the How to Guide of the Online Help for XLViewer. 
Reference Guide 
This item is used to access the Reference Guide of the Online Help for XLViewer. 
About XLView Designer 
This item displays version and copyright information pertaining to the XLView Designer.  

Appearance Tab 

 
The Appearance tab allows you to configure the look and feel of the XLViewer.  Each section of the Appearance tab 
is as follows: 
Style 
The XLViewer can be shown in three distinct styles.  For details about the Styles available, see XLViewer Styles. 
Style 1 
Style 1 consists of the XLViewer fixed on top of the Excel Viewer.  In this style, the XLViewer is glued to the top of 
the Excel Viewer, so when XLViewer is moved, the Excel Viewer moves with it.   
Style 2 
Style 2 consists of XLViewer appearing as a thin rectangle with Excel Viewer free floating on the screen.  The 
XLViewer cannot be moved, but the Excel Viewer can be moved and resized (if those options are enabled). 
Style 3 
Style 3 consists of XLViewer being completely invisible and the Excel Viewer free floating.  Note that in this style, 
only one file can be displayed in the Excel Viewer. 
 
General 
This section contains a few settings you may wish to use with XLViewer. 
Always on Top 
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The Always on Top setting keeps XLViewer and Excel Viewer on top of all non top windows.  By default this 
setting is enabled. 
Save Last Position 
The Save Last Position setting specifies whether or not XLViewer should save its position settings if a user moves 
XLViewer.  If this setting is not enabled, XLViewer and the Excel Viewer will always open in the positions 
originally set. 
 
Position 
Depending on the style chosen, the Position settings pertain to where XLViewer and the Excel Viewer are to be 
placed on the screen. 
To set the positions, click the Launch Viewer button.  This will invoke the Excel Viewer. 
Once the Excel Viewer is opened, manipulate the Viewer and place it where you want.  Then, click the Get Positions 
button and the settings for XLViewer and the Excel Viewer will be saved.  Excel Viewer will close automatically. 
Please note that in Styles 1 and 2 the XLViewer requires 80 pixels from top to bottom, so you cannot position the 
Excel Viewer less than 80 pixels from the top of the screen. 

Menus Tab 

 
The Menus tab contains all the enable/disable settings for the menus in the Excel Viewer.  Placing a check next to 
one of these settings makes the menu item enabled in the Excel Viewer. 
System Menu 
The System Menu settings control moving, sizing and maximization.  
File Menu 
The File Menu settings control the printing capabilities of the Excel Viewer.  To disable the entire File Menu, 
deselect the Enable setting. 
Edit Menu 
The Edit Menu settings control the editing capabilities of the Excel Viewer.  To disable the entire Edit Menu, 
deselect the Enable setting. 
View Menu 
The View Menu settings control the viewing capabilities of the Excel Viewer.  To disable the entire View Menu, 
deselect the Enable setting. 
Window Menu 
The Window Menu setting controls the ability to freeze window panes within the Excel Viewer.  To disable the 
entire Window Menu, deselect the Enable setting. 



 XLViewer WizReport XL 

 

Axeda WizReport™ XL 6.0 19/29 

Directories and Files Tab 

 
The Directories and Files tab provides you with all the tools you need to specify the Directories and Files you want 
the Viewer to display as well as the labels you would like the Directories and Labels to have in the Viewer. 
Directory Settings 
The Directory Settings section is where you specify the directories and files you want the XLViewer to show.  You 
are allowed to specify up to 9 directories.  
These Directory Settings determine which file or files can be listed in the XLViewer for viewing in the Excel 
Viewer. 
Start File 
The Start File setting contains a specific file that will open in the Excel Viewer when the directory containing the file 
is selected from the XLViewer or when XLViewer is loaded with this directory selected as the startup directory. 
When you choose a start file using the browse button provided, the path to the start file is automatically entered into 
the Directory setting for your convenience.  
If no start file is set, the most recent file in the directory will be shown when the directory is selected in the 
XLViewer or when XLViewer is loaded with this directory set as the startup directory. 
 
File Filter 
The File Filter setting contains the filter by which only the files you wish to allow the Excel Viewer to display will 
be listed in the XLViewer. 
By default, the file filter is set to *.xls.  This means that only files with the .xls file extension will be listed in the 
XLViewer.  The File Filter must contain .xls.   
 
Directory 
The Directory setting contains the path that contains the file or files you would like to display in the Excel Viewer.  
Directories can either be on the local machine or across the network. 
 
Directory Alias 
The Directory Alias setting contains a name for the directory you are showing.  This Alias will represent the 
directory in the list of directories in the XLViewer.  You can specify any name you wish for the directory. 
Please note that if you are using Style 1 or Style 2 you must specify a Directory Alias for every directory configured. 
 
Use as Startup Directory 
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The Use as Startup Directory setting specifies one of the directories configured to be the directory that will be 
selected when XLViewer is opened.  Either the Start File set or the most recent file in the directory will be opened in 
the Excel Viewer depending on whether or not a Start File is set. 
Please note that in Style 1 and Style 2 if no Startup Directory is specified, XLViewer will open with no directory 
chosen, but every directory configured will appear in the Directory combo box.  However, in Style 3 a startup 
directory must be specified in order for XLViewer to run. 
 
Labels 
The Labels section contains label settings for the lists in the XLViewer.  Specify a label for the directories you 
configured and the files that those directories contain. 
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XLViewer Example 

Introduction 
This chapter provides you a description of the sample configurations provided with XLViewer.   
These Samples are designed to work "right out of the box", meaning that you should be able to run them without 
changing anything in the viewer configuration file. 
The following provides an explanation for each sample provided, highlighting the features that each provide.  

Style 1 Sample 

Overview 

 
The Style 1 sample provided with XLViewer is a demonstration of XLViewer and Excel Viewer becoming a single 
entity as a viewing interface. 

Designer Settings 
Appearance Settings 
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The Appearance tab contains settings to alter the look and feel of XLViewer.  In this particular example, Style 1 has 
been chosen as the style.  Note that because Style 1 has been chosen, the left and right positions of XLViewer are the 
same as Excel Viewer and the bottom position of XLViewer is the same as the top position of Excel Viewer.  This 
makes XLViewer attached to the top of Excel Viewer. 
The Always on Top option has been enabled.  This means that the Viewer will always remain on top of the other 
open windows of the system. 
The Save Last Position option has also been enabled.  This means that the Viewer remembers its last positions and 
open to those positions the next time the Viewer is opened. 

 
Menus Settings 

 
The Menus tab allows you to enable or disable most of the options the Excel Viewer provides.  When a menu item is 
checked, it will be visible in the Viewer. 
In this example, all of the menu options provided are enabled.  Also, the Move option is enabled.   This option 
allows the Viewer to be moved around the screen. 

 
Directories and Files Settings 
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The Directories and Files tab contains all of the settings needed in order to configure files to be listed and shown in 
the Viewer. 
In this example, three distinct directory structures have been configured.  They are as follows: 
Utilities 
This Directory structure lists all of the files in the output directory of XLViewer that begin with "Chemical" and 
have the file extension .xls.  When this directory is selected, it will open the most recent file in the XLViewer Output 
directory beginning with "Chemical" and having the extension .xls. 
Water Treatment 
 This Directory structure lists all of the files in the output directory of XLViewer that begin with "Flow" and have the 
file extension .xls.  When this directory is selected, it will open the most recent file in the XLViewer Output 
directory beginning with "Flow" and having the extension .xls. 
Whole Plant 
This Directory structure lists all of the files in the output directory of XLViewer that have the file extension .xls.  
This directory has been configured as the Startup Directory, so it will be the first one selected when XLViewer is 
opened.  When this directory is selected, it will open EngineSample.xls, the Start File set. 
Note that the same directory is used for each of the three directory structures.  This is done for demo purposes, but in 
real life you would probably use 3 different directories. 
A File Label and a Directory Label have also been provided.  These labels appear above the list of directories and the 
list of files in the XLViewer. 
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Copyright, License, and Warranty 

Software License Agreement 
 
Copyright 2005, SyTech, Inc. 
XLViewer is a  trademark of SyTech, Inc. 
 
All rights reserved. 
 
This License allows you to: 
Use the software on only one (1) computer.  If you want to use this software program on more than one (1) 
computer, you need to purchase additional copies of this software from your dealer, or purchase a multi-unit license. 
Make one copy of the software program for backup purposes.  The backup copy must contain the complete program 
name, copyright and trademark notices.  Backup copies are for your use only and cannot be assigned or transferred to 
another person or used on another computer. 

 
RESTRICTIONS.  You may not sell, rent, lease, loan, transfer, distribute, copy electronically or transfer any copy 
or part of this program. 
NO REVERSE COMPILATION.   You may not modify, translate, disassemble, decompile or create derivative 
works of this software program or any copy in whole or in parts. 
NO OTHER RIGHTS.  Except as stated herein, this Agreement does not grant you any rights to patents, 
copyrights, trade secrets, trade names, trademarks (whether registered or unregistered) or any other rights, franchises 
in respect to this software program and its documentation. 
TERM.  This License is effective until terminated.  You may terminate it at any time by destroying the software 
program together with backup copies.  SyTech, Inc. may terminate this License immediately if you fail to comply 
with any of the terms and conditions of this Agreement.  You agree upon such termination to destroy the software 
program, the documentation and any and all copies thereof. 
TRANSFER.  You may not transfer, sublicense or assign the license or the program except as expressly provided in 
this agreement.  Any attempt otherwise to sublicense, assign or transfer any of the rights, duties or obligations 
hereunder is void. 
WARRANTY DISCLAIMER/LIMITED WARRANTY.  This software is provided “as is” without warranty of 
any kind, either expressed or implied, included, but not limited to the implied warranties of merchantability and 
fitness for any particular purpose.  The entire risk as to the quality and performance of the software and its 
documentation is with you.  Should the software prove defective, you (and not SyTech, Inc.) assume the entire cost 
of all necessary servicing, repair, or corrections.  Some states do not allow the exclusion of implied warranties, so the 
above exclusion may not apply to you.  This warranty gives you specific legal rights and you may also have other 
rights which vary from state to state. 
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MEDIA WARRANTY.  To the original purchase only, SyTech, Inc. warrants that the magnetic disks on which the 
software is recorded to be free of defects and faulty workmanship under normal service and use for a period of 90 
days from the date the software is purchased and delivered to you.  Your exclusive remedy in the event of a defect in 
the disks is limited to replacements of the disks. 
LIMITATIONS OF REMEDIES.  In no event will SyTech, Inc. be liable to you for any damages, including any 
loss of profits, or other incidental or consequential damages arising out of the use or inability to use this software 
even if SyTech, Inc. has been advised of the possibility of such damages, or for any claim by any other party.  Some 
states do not allow the limitations or exclusion of liability for incidental or consequential damages, so the above may 
not apply to you. 
 
You acknowledge that you have read this Agreement, understand it and agree to be bound by its terms and 
conditions.  You further agree that it is the complete and exclusive statement of the Agreement between you and 
SyTech, Inc., which supersedes any proposal or prior agreement, oral or written and any other communications 
relating to the subject matter of the Agreement. 
GENERAL.  This Agreement will be governed by the laws of the state of Massachusetts.  If any provisions of this 
Agreement shall be held by any court of competent jurisdiction to be contrary to the law, that provision will be 
enforced to the maximum extent permissible, and the remaining provisions in this Agreement will remain in full 
force and effect. 
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